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Welcome to Perfect Resize

Get the highest quality image enlargements with Perfect Resize, which features Genuine Fractals®
technology—patented, fractalbased interpolation algorithms—that quickly enlarge your images
without the loss of sharpness or detail that you might normally expect. Relied on by industry
professionals, you too can create high quality enlargements easily and showcase your images at their
best—even those taken with your mobile device!
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Introduction

This introductory chapter includes general helpful information about how to use this help system, how to contact onOne Software, how to install and access the
software, etc. It covers many of the foundation topics that you will need to understand to get started.

Pages in this Section

Using the Help System
Contacting onOne Software
Additional Help
System Requirements
Installation
Licensing and Registration
Opening and Saving Files
Using Modules
Using as Standalone
Using with Adobe Photoshop
Using with Adobe Lightroom
Using with Apple Aperture
Using with Other Applications
Managing Extras
Preferences
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Using the Help System

This user guide is html based and readable in most web browsers. On the left side, you will see a table of contents that make it easy to find the section you are
looking for. The table of contents is hyperlinked and will take you to the specified section by clicking on them. The main body of the page will show you the
content you have requested. Use the scroll-bar at the right to scroll down for additional content. You may see hyperlinks in the body text. They will be blue and
underlined. Clicking on one of these hyperlinks will take you to more relevant information.

You use the same forward and back buttons in your browser to navigate this user guide as you would a regular web page. You can even bookmark pages so
you can find them quickly later.

If you don't see what you are looking for in the table of contents, try the search field at the upper right. You can type in what you are looking for and an index
of pages will be created automatically that contain your search term.

Printing the Manual

 You can print individual pages by pressing the Print button at the top of the page. A complete printable PDF version of this user guide is available in the user
guide section of the onOne website. This version may be downloaded and viewed when you do not have an internet connection. The PDF version may also be
installed on your tablet or eReader device for viewing off our computer.
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Contacting onOne Software

 At onOne Software, we value our customers and offer a variety of ways to be contacted.

• Visit our company website at:

   www.onOnesoftware.com

• For technical support please visit: 

   www.onOnesoftware.com/support

onOne Software, Inc.

15333 SW Sequoia Parkway Suite 150 
Portland, OR 97224
Telephone: 503-968-1468
Fax: 503-968-1469

© 20072014 onOne Software, Inc. All rights reserved. onOne Software is a registered trademark of onOne Software, Inc. The onOne Software logo are trademarks
of onOne Software, Inc. Adobe, Photoshop, Photoshop Elements, Lightroom are either registered trademarks or trademarks of Adobe Systems, Incorporated in the United
States and/or other countries. Mac OSX, the Mac logo, iPhoto and Aperture are trademarks of Apple, Inc., registered in the U.S. and other countries. Microsoft, Windows
7, Windows 8 are registered trademarks of Microsoft Corporation. All other trademarks are the property of their respective owners. The activation system used
by onOne Software, Inc. is licensed under Patent No. 5,490,216. For a full list of license disclosures view the LICENSE.TXT file installed with the software.
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Additional Help

 

Technical Support
Contact technical support at www.ononesoftware.com/support or by filing out a request form.

 

Knowledge Base
Search the Knowledge Base for common issues, tips & tricks, and compatibility questions.

 

Frequently Asked Questions
Check the list of Hot Topics on the onOne web site. This covers the most frequently asked questions.

 
Video Tutorials
Visit the onOne University for free online video tutorials and archived webinars. Many users find these to be the best and fastest way to get
started and learn new techniques.
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System Requirements

Minimum Recommended

Operating
System

Mac OSX 10.7, 10.8, 10.9 
Windows Windows 7 or Windows 8 
current maintenance releases, 64 bit only

Mac OSX 10.8, 10.9
Windows Windows 7 or Windows 8 
current maintenance releases, 64 bit

Processor Intel Core 2 Duo, Xeon or better processor(s)
Quad-core Intel Core i5, Xeon or better
processors(s)

RAM 8 GB RAM 8+ GB RAM

Hard Drive 1 GB for installation
1 GB for installation 
Fast 7200 RPM or SSD drives

Display
OpenGL 2.0 compatible video card with 256 MB
dedicated video RAM, 1280x720 resolution

OpenGL 4.0 compatible video card with 1GB
dedicated video RAM, 1920x1080 resolution

Optional
Application
Integration

Photoshop CS5, CS6, CC, CC 2014 
Photoshop Elements 10, 11, 12
Photoshop Lightroom 4, 5
Apple Aperture 3.4

Photoshop CS6, CC, CC 2014 
Photoshop Elements 11, 12
Photoshop Lightroom 5 
Apple Aperture 3.4

Other
Internet connection for activation, auto update
checking, content downloads and tutorials. 
Adobe Flash Player

Wacom tablet for pressure sensitive input 
Hardware display calibration tool 

 

 

About Windows Video Cards

If you are using Perfect Resize from a Windows based computer, it is important that you have the latest drivers for your video card installed to get the best
performance. Check with your video card manufactures website for the latest drivers. Be sure your video card is OpenGL 2 compliant and has 256MB or more of
dedicated VRAM. Many integrated video cards on low-end laptops may not meet these requirements.
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Installation

To install Perfect Resize, double click the installer icon and allow the installer to guide you. You may have downloaded the installer from the onOne Software
website or it may be on a DVD if you elected for a physical shipment.

 

You should close any supported host applications such as Photoshop, Lightroom or Aperture as well as any standalone versions of
onOne products before installing or updating.

Mac OSX

The application is installed in the Perfect Resize folder in the Applications folder.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Resize is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folder.

Windows

The application is installed in the Perfect Resize directory in the onOne Software directory in the Program Files directory.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Resize is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into \ProgramData\onOne Software\.

Uninstalling

To uninstall Perfect Resize, follow these instructions. 

 

You should deactivate your product before uninstalling. This will allow you to transfer your license to another computer. 

Mac OSX

1. Go to the Applications/Perfect Resize/Documentation folder.
2. Double click on the Remove Perfect Resize application.

Windows

1. Go to Control Panels.
2. Under Programs select Uninstall a program.
3. In the list that comes up select Perfect Resize and then click on the Uninstall button.
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Licensing and Registration

Perfect Resize will operate as a trial version for 30 days from when it is installed. If you have purchased Perfect Resize, you will want to license it so you can
continue to use it past the trial period. When you install Perfect Resize it will prompt you to license it. Simply click on the license button and enter your license
code. Your license code can be found in your order confirmation email if you purchased the download version directly from onOne Software. If you purchased a
physical copy of Perfect Resize, a sticker on the information card will have the license code on it. Your license code allows you to install Perfect Resize on two
computers. When you enter your license code, Perfect Resize communicates with the onOne activation server and will activate your software. Your software
must be licensed and activated to function past the trial period. If the computer you are activating does not have access to the internet, you can manually
activate your software by following the manual activation instructions in the license dialog.

If you wish to move your copy of Perfect Resize from one activated computer to new computer you will need to deactivate it first. Deactivation is a simple
process. Simply open Perfect Resize and select Deactivate from the Help menu. This will deactivate Perfect Resize on the current machine, allowing you to install
and activate it on another machine. 

If you lose your activation code, have your computer stolen and can not deactivate it, need to install on more than two computers or have other activation
issues please contact onOne customer service at 1-888-968-1468 or visit the support section of the onOne software website. 

It is important to register your copy of Perfect Resize if you did not purchase it directly from onOne Software, so we can provide you with the best possible
service. Registered users of Perfect Resize are eligible for free technical support, information regarding new versions and products, free updates, upgrade
pricing and special offers on new products.

Product Improvement Program

We believe that the best products are made by listening to our customers. We use many methods to gather your ideas and feedback including: emails, surveys,
direct conversations, market analysis and the Product Improvement Program. The Product Improvement Program is built into our software and gathers
information about how our software is used. It is the most accurate way for us learn what features are important to you and how our products fit into your
workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you use our programs and basic information about your
computer. This information helps us learn what features are important to you and how we can make our software easier to use. No personal information is
collected and you will not be contacted. 

You can choose to participate in the Product Improvement Program the first time you launch an onOne product. You can change your participation later, just
click the Help menu, then Help Improve onOne Products. 

You can learn more about the Product Improvement Program here.
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Opening and Saving Files

Supported File Types

Perfect Resize uses the Photoshop (PSD) file format as its default file type. The Photoshop file format is a commonly supported, publicly documented file format
that is also the standard file for Adobe Photoshop. It is also supported by Photoshop Elements, Lightroom, Aperture and many other image editing applications.
It supports multilayered images and layer masks making it the perfect format for durable, adjustable imaging. Perfect Resize also supports the opening and
saving of the following file types, in RGB either 8 or 16 bits per pixel.

Photoshop (PSD)
Photoshop Large Document (PSB) 
Tagged Image File Format TIFF (TIF)
Joint Photographic Experts Group JPEG (JPG)
Portable Network Graphic (PNG)
Camera Raw files from over 200 digital cameras

Photoshop PSD files will maintain all the layers and layer masks you create in Perfect Resize and are recommended as your main file format. If your saved file will
be larger than 2 GB or 30,000 pixels on a side, your image will automatically be saved in the .PSB or Large Document format. This is a newer version of the PSD
file format and still maintains all your layers and masks. 

You can use the Edit a Copy or Save As command to save flattened TIF and JPG files or PNG files with transparency. Camera raw files can only be opened, not
saved directly. They must be saved as another file type.

Opening Files

You may open an existing file in several ways.

1. Selecting a file(s) in the Browse module, then clicking on another module, like Layers or Effects.
2. Open the file from the File > Open menu if you are using the Layers module.
3. Dragging a file onto the Perfect Resize icon.
4. Sending a file to Perfect Resize from a host application like Photoshop or Lightroom using the Perfect Resize plug-in.

When opening an existing PSD file that has been editing in Photoshop it may contain unsupported layer types such as text layers, adjustment
layers, etc. you will see a warning. You can still open a flattened version of the image if this happens. You can learn more here.

Opening Options
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When you open a file(s) in the standalone application you will be presented with the
dialog to the right. It allows you to choose to work on the original file, a copy, or to
stack the files together as layers.

Edit a Copy: A copy of the original file is made using the Copy Options below
and saved in the same folder as the original.
Edit Original: The original file is edited directly. This overwrites the original file
with your changes. This option is disabled for Raw or read-only files.
Add as a Layer: The original file is added as a layer(s) into the current image
in Perfect Layers. If no image is opened, a copy of the first image in your
selection is created.

If you select to open a copy, you can control the file type, color space, bit-depth and
resolution. If you have multiple files selected, they will all be handled the same way. 

 

Saving Files

1. You may save the open file using the save option command in the Layers module anytime.
2. If you opened your image from the Browse module, simply return to Browse to save and close the file.
3. If you have accessed Perfect Resize using a plug-in from another application, follow the instructions from that application for saving.
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Using Modules

Perfect Resize is a complete photo editor. It uses a modular approach, allowing each module to focus on one task. This makes accomplishing the task easier by
removing unnecessary tools and giving access to just what you need to get the task done. When used as a standalone application, Browse is the default module
upon first launch, it is used to navigate your drives and cloud services to find images to begin working.  In the Preferences you may change the default startup
module to Perfect Layers. If you prefer a layered workflow you can use the Layers module as the heart of your workflow, similar to using Adobe

Photoshop. Depending on how you access Perfect Resize you may never notice Browse or Layers.

The Module Selector

If you access Perfect Resize as a standalone application you will start in
Browse or Layers module.

When you are ready to edit an image you will select the module you wish
to use from the Module Selector in the upper right corner of the main
window. You can easily switch between modules by clicking on another in
the Module Selector. This allows you to perform multiple tasks during the
same editing session.

When you have completed your work, you return the Perfect Layers
module to save your work.

 This is the module selector from the Perfect Photo Suite. It contains all of the
available modules that onOne Software makes. If you have purchased a single
product, you will only see that product module and Perfect Layers in your module
selector.

If you access Perfect Resize as a Photoshop Plug-in you see the Module selector, but it will be disabled, you can only use one module at a time through
Photoshop. The Module Selector will also be disabled if you use the following modules through Lightroom or Aperture:

Perfect Portrait
Perfect Effects
Perfect B&W
Perfect Enhance
Perfect Resize

When you access these modules, you use them on their own and then return back to Lightroom or Aperture directly. Your file will be saved and closed
automatically. If you access Layers or Mask through Lightroom or Aperture you will start in the Layers module.

 

If you want to have access to all your modules during an editing session from Lightroom or Aperture, select the Perfect Layers plug-in. This will start
you in Perfect Layers and the Module Selector will be visible, allowing you to access all of the installed modules. 
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Using as Standalone

Perfect Resize can be used as a standalone application without the need of Photoshop, Lightroom or other host application. To launch it follow these steps:

Mac OSX

1. Open your Hard Drive.
2. Navigate to the Applications folder.
3. Navigate to the Perfect Resize folder.
4. Double click on the Perfect Resize application icon.

You can add Perfect Resize to your dock for easy access by clicking and holding the icon in the dock, then select the Keep In Dock option. If you use Launchpad
it can be found there as well.

Windows 7

1. Go to your Start Menu.
2. Select the onOne Software group.
3. Select Perfect Resize.

If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Resize from there.

Windows 8

1. Open the Start screen by pressing the Window key.
2. Select Perfect Resize.

If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Resize from there.
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Using with Adobe® Photoshop®

 If you have the Premium Edition of Perfect Resize, you can access it as a plug-in through Adobe® Photoshop® or Photoshop® Elements®. This
includes the onOne panel for Photoshop for fast access to plug-ins and their presets. As a Photoshop plug-in you can use modules in the Photoshop
workflow. This includes using selections and masks as well as Smart Objects and Smart Filters. You can also record actions for automating and batch
processing.

If you do not have the Premium Edition of Perfect Resize and would like to use it inside of Photoshop, contact onOne Customer Service about
upgrading to the Premium Edition. 

To use Perfect Resize inside of Adobe Photoshop
follow these steps:

1. Open the image you want to work on.
2. Select the layer you want to work on.

Generally Perfect Resize works on a copy of
your selected layer, not the entire image.

3. From the File menu, select Automate, and
then the module you would like to use. 

 

 To use Perfect Resize inside of Adobe Photoshop
Elements, follow these steps:

1. Open the image you want to work on.
2. Select the layer you want to work on.

Generally Perfect Resize works on a copy of
your selected layer, not the entire image.

3. From the File menu, select Automation Tools,
and then the module you would like to use. 

 

 

 Perfect Layers and Browse are not accessible from Adobe Photoshop or Photoshop Elements. 

 

 You can use the for Adobe Lightroom and Apple Aperture Edition inside of Adobe Photoshop Elements as well. 

onOne Panel
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Users of Adobe Photoshop CS5 and higher can also access Perfect Resize as plug-ins using
the onOne Extension Panel. This provides fast access to the Perfect Resize and its presets.
To access the onOne panel, go the Window > Extensions menu in Photoshop and select
onOne. 

The onOne panel behaves just like any other panel in Photoshop. It can be minimized or
nested with other panels. To access a module, simple double-click on it. To use a preset,
single click on the module name. A menu of available presets will be displayed. Simply double-
click on one to apply it to your selected layer.

 

If you wish to record actions using Perfect Resize be sure to access it from the
File > Automate menu when recording.
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Using with Adobe® Lightroom®

If you have the Premium or for Adobe® Lightroom® & Apple® Aperture® version of Perfect Resize you can access Perfect Resize as a plug-in inside
of Lightroom. This provides an integrated, round-trip workflow.
 
Perfect Resize is the perfect companion for Adobe Photoshop Lightroom. It integrates tightly with it and provides a seamless experience for
enhancing your images. There are several ways to use Perfect Resize with Lightroom. 

Plug-In Extras

Perfect Resize can be accessed from the File >
Plug-in Extras menu. This is the preferred way to
access it. It gives you access to all installed
modules and has the most flexibility in how the files
are handled. To edit an image in Perfect Resize
follow these steps.

1. Select the image in Lightroom.
2. Go the File menu and select the Plug-In

Extras flyout.
3. Select the module you would like to use.

When you access Perfect Resize as a plug-in from
Lightroom the module selector is only available for
Perfect Layers or Perfect Mask. When you select
one of these modules you can use as many
modules as you desire during the same editing
session. At the end of the editing session you must
save and close the image from the Perfect Layers
module.

When you select a module other than Perfect
Layers or Perfect Mask your image will be sent to it
directly and when you press Apply, the image is
saved and closed automatically and you are
returned back to Lightroom.

Selecting Multiple Images
If you have multiple images selected, the behavior
varies depending on which modules you select.

Perfect Layers or Perfect Mask: Each file
will be opened in its own tab. Then you
may access any modules available in the
Module Selector.
All other plug-ins: Each image is opened in
turn and you may adjust the settings on an
image by image basis.

 

Lightroom Plug-in Preferences 

When you use Perfect Resize through the Plug-In Extras menu there are important
file handling options that are controlled in the Preferences dialog of the Perfect
Layers module. These need to be configured in advance based on your desired
workflow.

File Type: The file type drop-down menu determines what type of file will
be created. The default is PSD, which maintains layers. You can also select
JPG or TIF if you prefer those formats and are not concerned about
maintaining layers. The last option is same as source, which maintains the
file type of the original file, except for Camera raw files which are saved as
PSD.
Color Space: The color space drop-down menu determines what RGB
working color space is used; Adobe RGB 1998, sRGB or ProPhotoRGB.
Bit Depth: The bit-depth drop-down menu determines the bit depth,
either 8-bit or 16-bit per pixel.
Resolution: The resolution drop-down menu determines the resolution of
the file.
Stack with Original: When enabled, the new image is stacked with the
original image, making it easier to organize.
Use Original for Single PSDs: When enabled, if you select a single PSD
file, it will be edited directly, rather than having a copy made.

 

External Editor
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You can also access modules as
external editors for all modules
except Perfect Layers or Perfect
Mask. You can access them from
the Edit In... contextual menu.
These behave similarly to the
plug-ins in the Plug-In Extras
menu but ignore the preferences
set in Perfect Layers. Instead
you have the option to control a
subset of these options each time
you access a module, in the same
way you do when you access
Photoshop or any other external
editor.  

Batch Processing

There are two ways to batch process multiple images in Lightroom with Perfect Resize. 

Perfect Batch

Perfect Batch is the preferred way to batch process. You start with a selection of
images in Lightroom or folder on disk, then batch-process them with multiple modules
at the same time to solve complex workflows. For example a portait photographer
can prepare images for a sales session by retouching every face, adding their
stylized look and output small JPGs with their logo watermark, all in the same batch
process. You can access Perfect Batch from the File > Plug-In Extras menu in
Lightroom. You can learn more about using in the Perfect Batch section of this user
guide.

Key batch processing features include:

Start with a selection of images from Lightroom or any folder
you select.
Batch process with a single module for simple jobs or create
workflows where you string multiple modules together.
Save workflows to use over and over.
Pause on the first image to confirm your set-up, then
automatically process the rest to match.
Add a visual watermark, like your logo, to every image.
Edit files in place or create new files with different size, name or
file type.

 

 

Lightroom Export
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You can also batch process with a single module
through the Export menu in Lightroom. This is useful if
you need to remove metadata or are more
comfortable with Lightroom's Export. Batch processing
through Export is driven by presets, so you need to
create a preset that accomplishes the work you desire
first.

1. Select the images you wish to batch process.
2. Go the Export under the File menu.
3. At the top under the Export to drop-down,

select the module to use.
4. Complete the module specific options below.

These will start with the preset, followed by
options for selecting the export location, file
naming, file size, etc.

5. Press the export button.

 

You cannot save Lightroom export
presets or use the Export with
Previous option. 
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Using with Apple® Aperture® 

If you have the Premium or for Adobe® Lightroom® & Apple® Aperture® Edition of Perfect Resize you can access Perfect Resize as a plug-in inside
of Aperture. This provides an integrated, round-trip workflow.

Perfect Resize integrates tightly with Apple Aperture and provides a seamless
experience for enhancing your images.

Perfect Resize can be accessed from the Photo > Edit with Plug-In menu. To
edit an image in Perfect Resize follow these steps.

1. Select the image in Aperture.
2. Go the Photo menu and select the Edit with Plug-In flyout.
3. Select the module you would like to use.

When you access Perfect Resize as a plug-in from Aperture the module selector
is only available for Perfect Layers or Perfect Mask. When you select one of
these modules you can use as many modules as you desire during the same
editing session. At the end of the editing session you must save and close the
image from the Perfect Layers module.

When you select a module other than Perfect Layers or Perfect Mask your
image will be sent to it directly and when you press Apply, the image is saved
and closed automatically and you are returned back to Aperture.

Selecting Multiple Images

If you have multiple images selected, the behavior varies depending on which
modules you select.

Perfect Layers or Perfect Mask: Multiple images will be opened in
separate tabs.
All other plug-ins: Each image will open in a series so you can adjust the
settings on each image.

  

 

The file type, bit-depth and color space of the image is determined by the preferences in Aperture for external editors. Perfect Resize will maintain the
file type, either PSD or TIF automatically to support compatibility with plug-ins from other manufactures. Keep in mind only PSD files store re-editable
layers and mask.

Batch Processing

Perfect Batch is the preferred way to batch process. You start with a selection of
images in Aperture or folder on disk, then batch-process them with multiple modules
at the same time to solve complex workflows. For example a portait photographer
can prepare images for a sales session by retouching every face, adding their
stylized look and output small JPGs with their logo watermark, all in the same batch
process. You can access Perfect Batch from the Photo > Edit with Plug-in menu in
Lightroom. You can learn more about using in the Perfect Batch section of this user
guide.

Key batch processing features include:

Start with a selection of images from Lightroom or any folder
you select.
Batch process with a single module for simple jobs or create
workflows where you string multiple modules together.
Save workflows to use over and over.
Pause on the first image to confirm your set-up, then
automatically process the rest to match.
Add a visual watermark, like your logo, to every image.
Edit files in place or create new files with different size, name or
file type.
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Using with Other Applications

You can use Perfect Resize as an external editor with many other workflow applications such as Adobe Bridge or Apple iPhoto. First check the application user
guide to see if it supports external editors. It should detail how to configure the host application to use an external editor. Generally this will include selecting
Perfect Resize setting the file type to send to it. It is best to use PSD files if supported. Below are the instructions for configuring iPhoto. 

1. Open the Preferences dialog, from the iPhoto menu.
2. Click on the Advanced tab.
3. From the Edit Photos: pop-up select the In Application... option

(note if you have ever selected another external editor, it may be
listed here instead.)

4. From the Choose dialog that appears, navigate the the Perfect
Resize folder, inside the Applications folder and select [Product
Name].

5. In the RAW Photos: option, uncheck the Use RAW when using
external editor option, and check the Save edits as 16-bit TIFF
files option .
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Managing Extras

What are Extras?

The Extras Manager let's you import and manage
your own Extras content. Extras are:

Backgrounds that can be imported and
used in Perfect Layers.
Borders than can be imported and used in
Perfect Layers, Perfect Effects and
Perfect B&W.
Textures that can be imported and used
in Perfect Layers and Perfect Effects.
Presets for Perfect B&W, Perfect Effects,
Perfect Enhance, Perfect Portrait and
Perfect Resize.

Extras can be content that you download from
the onOne website or content that you create on
your own.

The Extras manager lets you create categories
for each Extra type, import files as extras and
delete user-added extras you no longer want.

You can access the Extras Manager from the File
menu in Browse and Perfect Layers or the Preset
menu in modules that use presets.

 

 

How to Import Extras

Importing extras is simple. Start by opening the Extras Manager then follow these steps.

1. Select the type of extras you wish to import in the left column (Backgrounds, Borders, etc.) You can only import extras of one type at a time.
2. Click on the Import button in the footer of the left column. A Finder or Explorer Window will appear where you can select the files to import. If you

want to import an entire folder, click into the folder then select the first file, then shift-click on the last file. Click import when you selection is
complete

3. Select a category for your extras to live in. This is where you will be able to find it inside of the Perfect Resize. You can select from an existing
category or create a new one.

When your extras have been imported you will see them in the Extras Manager in the category you selected, in the type of extra they belong to.

What Type of Images Can I Import as Extras?

Backgrounds and Textures may be any image file that Perfect Resize can open including jpg, tif, raw or psd files. Border files
must have a large central area that is transparent. This means that only files that support transparency like png can be imported
as borders.

 

If you have a .ONPreset file that you have downloaded from the onOne Software website, simply double-click on it to install it. There is no need to
import it through the Extras Manager. 
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Browsing Extras

You can browse and open Extras from the Browse
module. In the Sources pane there are sources
for onOne Extras (extras that are provided by
onOne when you installed Perfect Resize) and
User Extras where you can browse and open
extras you have installed. 

Inside each source folder are folders for the
Backgrounds, Borders and Textures. You can
open these as layers into Perfect Layers to add
them to an image or layout you are working on.

 

 Using Extras in Perfect Layers

Browsing extras in Perfect Layers is similar to the
Browse module. Click on the Extras tab of the left
column mini-browser. You will see top-level folders
for onOne Extras and User Extras. Inside of
these will be sub-folders for Backgrounds,
Borders and Textures. You can double-click on an
extra to add it to your current image, just use the
"Add as a Layer" option when asked how you
want to open the file.

Then you can use the transform
tool to size and position the extra
on your image. 
Use the Layers pane to change the
order, opacity and blending mode.
Use the Masking Brush and
Masking Bug to selectively apply
the extra.
Use the Perfect Eraser to remove
distractions from the extra if
needed.

If you save your file as a layered PSD file, you
can always re-open the file again and have
access to all of the layers and masks for further
editing.
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How to use in a Module

You can access certain extras, like borders and
textures, inside of modules like Perfect Effects
and Perfect B&W. To use them follow these
steps:

1. Open an image into Perfect Effects.
2. In the Filter Options pane, select the

correct filter type, either Borders or
Texturizer.

3. From the Category pop-up, select a
category you have imported. User added
extras categories appear at the bottom
of the category list.

4. From the Texture pop-up select a texture
from the category you selected.

 

 

 

How to Delete Extras

You can remove imported extras using the Extras Manager. Follow these steps:

1. Open the Extras Manager.
2. Click on the extras type that contains the content you wish to remove. This will display categories within that extras type.
3. To delete an entire category, select in the left column and click on Delete button in the footer of the left column.
4. To delete individual extras, select them in the right column and click on the Delete button in the footer of the right column.

 
 Deleting extras is permanent and can not be undone!

See also

Using the Help System
Contacting onOne Software
Additional Help
System Requirements
Installation
Licensing and Registration
Opening and Saving Files
Using Modules
Using as Standalone
Using with Adobe Photoshop
Using with Adobe Lightroom
Using with Apple Aperture
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Using with Other Applications
Preferences
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1. Working Color Space: When a new file is created or file is
opened and has no color profile associated with it, this is the
assumed color profile for the image. Images that come from
other hosts or have tagged or embedded profiles will use the
associated profile instead.

2. Scrolling Controls: Lets you select how the mouse scroll
wheel or scrolling gesture works. The options are:

1. None: Default
2. Preview Zoom: Adjusts the zoom of the preview

window. Scrolling up increases the zoom, scrolling
down decreases the zoom. It is important that the
zooming is comfortable, not too fast or slow or jerky.

3. Preview Pan: Pans the image, like using the pan
tool or navigator. It is important that the panning is
comfortable, not too fast or slow or jerky.

4. Brush Size: Adjusts the size of the current tool if
relevant, such as a brush tool.

3. Preview Background Color: You may select the color of
the background behind the preview image. The default color
is black. There should be options for black, white, light gray,
dark gray and custom... The custom option a color picker
where you can select your own background color

4. Start In: Determines which module will open at
launch. Browse is the default. 

5. Remember Last Browsed Folder: Enabled by default this
will will open the last browsed folder when you launch the
program. 

6. Check of Updates on Launch: Enabled by default, the
product will communicate with onOne server at launch and if
an update is available it will prompt you to download, or skip. 

7. Warn when leaving files in Layers: Enabled by default,
if you have unsaved files open in Layers and want to close
the program a warning dialog will appear with the options to
Save & Close, Cancel, or OK which will close without saving. 

 

 

1. File Type: Specifies four options. PSD (Supports Layers,
Defaults Setting. Same as Source (PSD for Raw). TIFF (No
Layers). JPEG (No Layers).

2. Color Space: Specifies the color space to use when
processing copies from Lightroom. This is similar to the
working color space pop-up in the general preferences tab,
however there are only the three options supported by
Lightroom: sRGB, Adobe RGB 1998 and ProPhotoRGB.

3. Bit Depth: Sets the bit depth for the copies created by
Lightroom, the options are 8 and 16 bit.

4. Resolution: Sets the resolution of copies created by
Lightroom.

5. Stack with Original: Enabled by default, copies created by
Lightroom are stacked with their original or source image.

6. Use Original for Single PSDs: Enabled by default. If your
selection is a single PSD file, the original PSD is opened rather
than creating a copy.

 

 

 

Preferences

The preferences dialog contains general application settings. The preferences are accessed from the Perfect Resize menu on Mac or the Edit menu on
Windows.   

The preferences contain the following controls:

General Settings

Lightroom Plug-In Settings
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1. Memory Usage: Specifies the amount of system memory
(RAM) that is used by the application. The default is 80%.

2. VRAM Usage: Specifies the amount of video memory
(VRAM) that is used by the application. The default 80%.

 

 

 

Performance Settings
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Browse Module

The Browse Module is the perfect place to find the images you want to edit with Perfect Resize. It gives you
easy access to all your images, no matter where they live on your computer, network or cloud based storage
service. You can browse and search any file type that is supported. You can also view your images as a
thumbnail grid or larger detail view along with important metadata. 

Some of the features:

Find your photos fast, anywhere they live
Local drives
Network drives
Online storages services

Create a selection of images for Batch processing
Fast browsing without the need of a catalog
Copy, move, delete and rename files
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This getting started section will give you the basics of using the Browse Module.  You might also try watching the getting started video tutorial. For
detailed information on steps and controls mentioned in the getting started section, see the "Using the Browse Module" section instead. 

Pages in this Section
Browse Workspace
Finding and Opening Files 

 

 

Getting Started
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Browse Workspace

The Browse Module allows easy access to your images on your computer, network or cloud based storage device while viewing a thumbnail grid or scrolling
through a larger detail view. 

The Main Window:

 

 

The main window sections of Browse Module:

 A. Info Pane: This section will give you detailed information about your image when available.

 B. Sources Pane: This contains a list of common photo locations, including disks, favorites and cloud storage services.

 C. Folders Pane: This displays the hierarchical tree view of the current selected Source.

 D. Recent Pane: This keeps track of recently opened files and folders. 

 E. Module Selector: This lists the available modules.

 F. This will display the number of files and folders you are viewing, you can use the arrow keys to move from item to item.

 G. This is your main preview window where you can view your images as thumbnails or a larger detail.

 H. Use this button to switch from thumbnail view to detail view.

 I. This slider will adjust the thumbnail size in your main preview window.

 J. This pop up will adjust your sort from filename to date modified in your main preview window.

 K. This search box allows you to search by name the contents of the current folder.
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Finding and Opening Files

1. Start by selecting a source for your images in the left Sources pane. Any disks inside or attached to your computer will appear
as disks. Supported Cloud Storage services appear at the top of the list. Any favorites, like your Pictures folder, will appear at
the bottom of the list. 

2. Once you select your Source, navigate to the folder in the Folders pane to find your images. You can also do this within the
thumbnail matrix. Once you have found a file you wish to work on simply click on the file to select it. The thumbnail will appear
to be highlighted.  

3. Click on the module you want to use in the Module Selector located in the top right (A) or you can also right-click and choose
a module in the pop up menu (B).  

4. The Edit What dialog will appear with file options.  Select your options and click "Open" to begin working on your image. 
5. When you complete your work in a module, return to Browse to automatically save and close the image.  
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This section covers the complete use of the Browse Module. It includes how to navigate your folders, customize
sources as well as information on preferences and menu options.

Pages in this Section
Using the Info Pane
Navigating Sources
Navigating Folders
Navigating Recent Pane
Working in Thumbnail View
Working in Detail View
Managing Files and Folders
Opening an Image 
Menus
Keyboard Shortcuts

 

 

Using the Browse Module
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Using the Info Pane

The Info Pane displays the metadata for the currently selected file.  This information may include: 

Camera Make and Model
Focal Length
Capture Date and Time 
File Type
GPS Data
ISO
Shutter Speed
Aperture
Exposure Compensation value

 

 

  *If any of the metadata fields are unavailable they will be left blank.

Additional generic file information is also displayed in the Info Pane Including:

Filename

Colorspace (color profile)
Pixel Dimensions and Resolution
Image size and Bit depth

GPS Metadata

If your image has GPS metadata embedded in it, the GPS button will appear. Clicking on this button will open the default web browser to Google Maps and
navigate to the location where the image was taken. 
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The Sources Pane contains a list of cloud storage services, attached disks, and common or favorite
locations.

Cloud Storage Services

Browse supports several common cloud storage services including Dropbox, Google Drive, Microsoft Sky
Drive and Apply iCloud Photo Stream. All of these services keep local copies of your images on your
computer. Browse finds and monitors these locations automatically. If you edit an image stored in one of
these locations they are automatically updated to the cloud. 

Browse automatically finds the default installation locations for these services. If you do not have one of
these services installed, or you have it installed to a non-standard location you will be asked to install or
locate the folder when you click on the source.

 

iCloud Photo Stream is a read-only source. You can open an copy of an image from it and save it
to a new location only. 

Attached Disks

Browse automatically recognizes any disk (volume) inside or attached to your computer. This includes:

Hard drives in your computer
Hard drives attached to your computer with USB, Firewire, Thunderbolt, etc.
Optical drives
USB thumb drives
Digital camera memory cards
Digital cameras, music players and smartphones that support USB Mass Storage
Network drives

Disks appear in the middle of the Sources pane with a hard drive icon next to them. Keep in mind that
some disks, like optical drives, are often read-only. You will be able to open a copy of an image, but will be
prompted to save the image to a new location.

Favorites

Browse also supports creating Favorites. A Favorite is a short-cut to any file path where you store your
images. Several Favorites are installed by default such as your Desktop, Pictures and the onOne Sample
images folders. 

You can create your own Favorites by pressing the plus icon at the top of the Sources pane. An open
dialog will appear where you can navigate to the folder you wish to add as a Favorite. You can also
remove a favorite by selecting it in the Sources pane, then pressing the minus button.

You can also add a favorite by simply dragging it into the Sources pane.

 

Navigating Sources
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The Folders pane displays the hierarchical tree view of the current selected Source.  You
can close and open the subfolders by clicking on the triangle. You can navigate to your
folder of choice within the pane or you can also use your preview window. Keep in mind
that the Folder view only shows the folders, or directories inside the current source. This
helps to reduce clutter and make it faster to find the image you are looking for. If you need
to see folders outside of the current source, select the disk the images are located on
instead of the Favorite.

You can add a new folder, as a child of the current folder, by pressing the plus icon.
You can delete the current folder by pressing the minus icon.
You can rename a folder by right-clicking and selecting Rename.
You can move a folder by dragging it into another folder.

 

Navigating Folders

Browse Module  33

 

Perfect Resize



 

Navigating Recent Pane

The Recent Pane keeps track of recently opened files or manually browsed folders.  Files are listed in
order of last opened. If you have not opened any files this pane will be empty. You can quickly access
your most recent files in this pane by clicking on the one you want and it will appear in your main preview
window. Keep in mind the Recent pane only shows files you have opened directly from Perfect Resize,
not files you have sent to Perfect Resize from Lightroom, Aperture or Photoshop.

You can clear the recent file list by pressing the trash can icon.

 

  

34  Browse Module

Perfect Resize



 

Working in Thumbnail View
The Thumbnail area is the largest part of the main window and it is responsible for displaying thumbnails of folders and images you have selected using the
Source and Folder Panes. 

 

 

A. Adjust the size of the thumbnails using the slider located at the bottom or use "-/+" keys on your keyboard.

B. Change the viewing mode between thumbnail and detail view.

C. When Previewing images at full screen you can quickly go to the next image by using the navigational arrows.

D. Use the breadcrumbs to quickly return to the root or click "back" to return one folder.

E. Sort the thumbnails by filename or date using the pull down menu.  The sort will always be descending, A-Z or oldest to newest.

F. Search for folders or files in the current folder.

Selecting Multiple Images

Select the first image and hold down on the 'shift' key and click on the last image of the group.  If the images you wish to select are not in sequential order you
can select each image individually by selecting the first image, now hold down 'Command' (Mac) or 'Control' (Windows) and select each image(s) while continuing
to hold down on the Command/Control key. 

See also
Using the Info Pane
Navigating Sources
Navigating Folders
Navigating Recent Pane
Working in Detail View
Managing Files and Folders
Opening an Image 
Menus
Keyboard Shortcuts
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Working in Detail View
In Detail View you can see a full-screen version of images. By default when you go to Detail View, your images will be displayed in fit mode, so you can see the
entire image. However you can click on the image to zoom in to 100% or actual pixels. This is useful for judging small details and sharpness. Single-clicking on a
image that is magnified will return back to fit mode. You can click and drag a magnified image to look around. Your zoom mode is maintained as you move from
image to image so you can compare the same spot in several frames.

There is also a Navigator pane where you can reposition the preview and change the magnification amount.

See also

Using the Info Pane
Navigating Sources
Navigating Folders
Navigating Recent Pane
Working in Thumbnail View
Managing Files and Folders
Opening an Image 
Menus
Keyboard Shortcuts
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Navigating the Preview

This provides several ways to navigate and view your image in the Preview window. 

  

The Preview Window above is the main section where you preview and work on images.

 
 Hand Tool

The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area. 

 To pan (scroll) in the Preview window: 

Select the Hand Tool and drag the image until you locate the area you wish to view. 
With any other tool selected, hold down the spacebar while you drag the image in the window.

 

Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

 
Zoom Tool 

The Zoom tool changes the magnification of the image in the Preview window. 

With the Zoom tool selected:

Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

 

Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.
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Navigator

At the top of the control panel on the right of the main window is the Navigator | Info panes. It contains four useful tools for inspecting and viewing details
of your image.

The Navigator Pane

This gives you a birds-eye view of your image. The blue square region marks the image area
that is visible in the preview pane. You can pan your image by clicking and dragging inside the
blue region. 

At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate. 

FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%
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Managing Files and Folders
You can use the Browse module to organize, delete and rename files and folders. This makes it a useful workflow tool for any photographer.

 Deleting a file or folder  

To delete a file or folder in the preview area, simply press the delete key or
select delete from the right-click contextual menu.

Then confirm that you wish to move the file to the trash. If you make a
mistake you can use the undo command. If you have multiple files and or
folders selected it will move them all to the trash. Some files or folders, like
those on a network volume must be deleted immediately and cannot be
undone.

 

 Renaming a file or folder  

 

You can rename a file or folder by selecting it, then choose Rename from the right-click
contextual menu.

 

 Creating folder  

 

You can create a new folder from the the right-click contextual menu in the preview area or
by pressing the plus "+" icon in the Folders pane. This will create a new folder inside the
selected folder.

 

 Copying and Moving files and folders  

You can copy and move files and folders in the ways you are accustomed to on your
computer. You can select files and folders and use the copy command to copy them to the
clipboard and then the paste command to paste them to new location, inside or outside of
Browse. You can use this to copy a file or folder from one place to another or to attach an
image to an email for example.

You can also use the familiar drag and drop functions to copy or move files and folders.
Dragging and dropping a file or folder will move it if it is on the same drive or copy it to
another drive. You can drag and drop into and out of the Browse module.
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Opening an Image

Select the file and select a module from the module selector in the upper right menu bar or right click on the file and choose a module from the pop up menu. You
will be presented with the What to Edit dialog below.

What to Edit 

After you have selected a file and chosen a
module a File Options dialogue will appear.
 You can choose between: Edit a Copy, Edit
Original or Add as a Layer.

Edit a Copy- This is the default option.  A
copy of the image is created and will be saved
to the same path as the original file. After
you Save/Apply the file name will be (Original
Filename) copy.ext — with the extension you
have selected. 

Edit Original- This option will open the
original file and overwrite the current file
when saved. This option will be unavailable
for camera raw files or read-only files.

Add as a Layer- This opens the original file
and it is added as a layer in Perfect Layers.
 This option is only available for launching in
Perfect Layers. 

Copy Options

File Format- Choose one of the following
file formats you wish to work with.
 Photoshop (.psd) files will support layers, this
means when the file is saved all the individual
layers will be available again when re-opened.
For Tiff and JPEG no layers will be retained
and the Layers will be merged into a single
composite when saved. 

Color Space- This will list the RGB color
profiles installed on your system. 

Bit Depth- This sets the bit-depth of the
copied image. This option is unavailable for
JPEG format, which is limited to 8-bit.

Resolution- This sets the resolution or ppi
for the image, it is 300 by default. 

 

See also

Using the Info Pane
Navigating Sources
Navigating Folders
Navigating Recent Pane
Working in Thumbnail View
Working in Detail View
Managing Files and Folders
Menus
Keyboard Shortcuts
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Perfect Resize (Mac OS X Only)

About Perfect Resize: Opens the about box, displays your version
number and activation code. (Help menu on Windows)
Preferences: Opens the preferences dialog. (Edit menu on Windows)
Quit Perfect Resize: Quits Perfect Resize.

 

 

File Menu

Browse Folder: Opens the browse dialog where you can select which
folder you would like to browse
Add Favorite: Opens the add favorite dialog that you can add a favorite
folder permanently to the Sources pane
Manage Extras: Opens the Extras Manager where you can import and
manage extras like Borders, Backgrounds, Textures and Presets.
Edit in...: Will launch the module with the file you have currently selected  
Batch: Opens the Batch mode window

 

Edit Menu

Undo: Undoes the last file operation. This is only available the last thing you
did.
Redo: Redoes the undo operation. This is only available if the last thing you
did was an undo.
Select All: Selects all the images in the current folder
Select None: Deselects all the images in the current folder
Deselect: Deselects the current item
Copy: Copies the currently selected items
Paste: Pastes (copies) the items in the clipboard to the current location
Rename: Renames the selected file or folder
Delete: Moves the selected files and or folders to the trash
Add Subfolder: Adds a new empty subfolder inside the current folder

 

 

View Menu

Bigger Thumbnails: Increases the size of the thumbnails
Smaller Thumbnails: Decreases the size of thumbnails
Sort: Sort by filename or date
View Mode: Select from thumbnail or Detail view. 
Preview Background Color: Change the preview background color the
thumbnails

 

 

 

Menus
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Window Menu

Info: Opens and closes the Info pane.
Sources: Opens and closes the Sources pane.
Folders: Opens and closes the Folders pane. 
Recent: Opens and closes the Recent pane.
Show Browse Panel: Hides or reveals the entire Browse Panel (left column
of control panes).
Hide Panels: Hides or reveals both the left and the right Panels.
Full Screen Mode: Enters or exits full-screen mode

 

 

Help Menu

Search: Searches the menus (Mac OSX only).
Browse Online Help: Opens this html Help in your default web browser.
Video Tutorials: Opens the online Video Tutorial in your default web
browser.
Getting Started: Opens the online Getting Started overlay.
Show Keyboard Shortcuts: Opens the keyboard shortcut inspector.
Perfect Inspiration: Takes you to the Perfect Inspiration web site.
Check for  Updates: Checks with the onOne update server to see if you
are running the current version. If there is a newer version you will be
notified and be walked through the update process.
Deactivate: Opens the activation dialog. These are used to deactivate
your software for moving it to another computer or for a return.
Registration: Opens the default web browser and navigates to the
registration page of the onOne website.
Provide Feedback: Opens the default web browser and navigates to the
feedback page of the onOne website.
Help Improve onOne Products: Opens the Improve onOne Products
dialog.
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Keyboard Shortcuts

  Mac OSX  Windows

Browse Folder  cmd b  ctl b

 Exit  cmd q  ctl q

 Select All  cmd a  ctl a

 Select None  cmd d  ctl d

 Deselect  /  /

 Bigger Thumbnails  cmd +  ctl +

 Smaller Thumbnails  cmd -  ctl -

 Return to Thumbnail View  esc or g  esc or g

 Switch to Detail View  e  e

 Delete Item  delete  delete

 Copy Selected Items  cmd c  ctl c

 Paste Items from Clipboard  cmd v  ctl v

 Zoom in  cmd +  ctl +

 Zoom out  cmd -  ctl -

 Fit to screen  cmd 0  ctl 0

 Actual pixels  cmd opt 0  ctl alt 0

 Info  cmd 1  ctl 1

 Sources  cmd 2  ctl 2

 Folders  cmd 3  ctl 3

 Recent  cmd 4  ctl 4

 Hide Panels  tab  tab

 Full Screen Mode  cmd ctl f  F11

 Keyboard Shortcuts  cmd shift k  ctl shift k
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Perfect Resize 

Welcome to onOne Software™ Perfect Resize

Perfect Resize, the next generation of Genuine Fractals, is the industry standard for
image resizing. It is renowned across the photographic and printing industries for its ability
to increase image size over 1000% without the loss of sharpness or detail that you would
normally expect. Its patented, fractal based interpolation algorithms work like nothing else
and the results speak for themselves. Perfect Resize 8 allows you to crop and resize your
image in a single step with no guess work. Its new Tiling and Gallery Wrap features make it
easy to get your enlargements printed just the way you want. Fire up the batch
processing engine to resize an entire folder of images quickly. You can even access the
power of Perfect Resize inside of Adobe Photoshop, Lightroom or Apple Aperture.
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This getting started section will give you the basics of using Perfect Resize 8. If you have never
used Perfect Resize 8 before, this is a good place to start. You might also try watching the getting
started video tutorial. For detailed information on steps and controls mentioned in the getting
started section, see the "Using Perfect Resize" section instead. 

 

Getting Started
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How Big Can You Print

People often ask how large a print can be made with Perfect Resize. If your original image is sharp, has good details and little noise, you could go as large
as 1000% of the original size. 1000% is ten times the size of the original file. For example, an original file that is 8"x10" could be resized to 80"x100".
Viewing distance plays a big part of this. Standard viewing distances are two-times the diagonal of a print. For example, for an 8"x10" it would be about
two feet away. An 80"x100" would be about 21 feet. That seems like a lot but that image is almost 7'x9'. Keep in mind that many photographers scrutinize
their images closer than standard viewing distances. 

Images are perceived in color, tonality and sharpness. Other interpolation techniques maintain color and tonality but sacrifice sharpness by "inflating" the
image uniformly. The image still looks familiar but will not be crisp. Depending on the amount of interpolation, this can be severe and noticeable even at
standard viewing distances. Perfect Resize maintains the color, tonality, and sharpness of an image at all sizes. It will always look the same when viewed
at the proper distances. 

It is unrealistic to assume that the fidelity when viewed at 100% will be the same for an 8x10 and an 80x100 created by Perfect Resize. Perfect Resize will
maintain the edges which perceptually make the image sharp, but it cannot create detail where there was none in the past. When the shutter is pressed, a
finite amount of detail is captured. A good way to think about this is to look at an insect on a leaf. If you look at it with a magnifying glass, you will see
more detail than you did than when looking at it with the naked eye. Now if you take a digital photograph of that same insect and look at it in the computer
and zoom in past 100% you do not see any more detail. The information you see is limited by what the camera captured. Perfect Resize works the same
way, it can not create new detail but instead takes the finite amount of detail available and increase it in size.

Perfect Resize isn't magic. We have all watched CSI where they take a security photo and enlarge the reflection in the victim’s eye to see the killer, with
results that look amazing. This is pure science fiction. You cannot create detail where there was none before. But if your original file has good detail and
little noise, you will be able to make very good looking enlargements from your files. This is what Perfect Resize does better than any other software.
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How Much Resolution Do I Need? 

To answer this, you need to know two things: 

The size of the print you need to make.
The resolution that your printer needs for best results.

The size of the print is as large you would like. This may be limited by the size of your printer. Resolution is the density of the pixels for a given distance,
usually measured in pixels or dots per inch. Most modern inkjet printers print anywhere from 1200 to 4800 dots per inch (what the printer manufacturers
really mean is 1200-4800 droplets of ink per inch). Inkjet printers use many tiny round droplets of 4-12 ink colors to reproduce one square pixel in your
image that could be one of any millions of colors. A common mistake is to set the resolution of the file to the resolution of the printer. In all but a few
special printers this will lead to huge files that will not print well, if at all. The secret is that the human eye cannot see more than 250-300 pixels per inch.
So the ideal resolution for your files should be close to this. Once you know the print size and resolution, it is easy to use Perfect Resize 7.5 to resize your
file to the desired output. Simply input the resolution and then either the print width or height. You'll see that the corresponding dimension is automatically
filled in by Perfect Resize 7.5 based on the proportions of your image. 

Keep the proportions in mind because the proportions of film, digital camera sensors and paper can all be different. For example, most digital camera
sensors are proportioned so that the height is two-thirds the width or 1:1.5; While the most common paper size, in the US, is the letter which is 8.5x11
inches or about 1:1.25. These kind of proportion mis-matches are common and require that the original image be cropped to fit the proportions of the
paper size. If your image cannot be cropped without ruining the composition then you will need to adjust your print size to a longer dimension.

 

Understanding Resolution

Resizing an image larger than the original size requires new pixels to be created. This process is called interpolation or resampling. There are many
mathematical ways, called algorithms, to do this. The most common method used by many pixel editing applications is called bicubic interpolation. Bicubic
along with its newer variants bicubic smoother and bicubic sharper work by averaging a small group of neighboring pixels to determine the color value of
the new pixels to be added. While this technique is fast, it does not distinguish edges so there is a uniform loss of sharpness and detail across the image. 

Perfect Resize patented scaling algorithm is fundamentally different from bicubic or other interpolation methods. While other methods sample nearby pixels
and decide new pixel values one by one, Perfect Resize uses a sampling technique called Fractal Scaling.  Fractal Scaling samples nearby "blocks," square
groups of pixels, and varying sizes, compares them to smaller versions of the original image and mosaics these patches together to create a larger version
of the original. By doing this repeatedly, often the characteristics of the image like edges, smooth areas, and textures are reinforced for each larger
version. Noise is de-emphasized and sharp details are maintained. All this number crunching may take a bit longer than the single pass interpolation
methods like bicubic, but good things come to those who wait and the reward is far superior results.
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When Should I Use Perfect Resize

Perfect Resize should be used as one of the last steps in your workflow before printing. The power of Perfect Resize is in the concept of resolution on demand.
You can work with a modest size file, which makes your editing faster and takes less hard drive space and memory. Then when you are ready to output your
file, you resize it with Perfect Resize to the desired size and sharpen it for output. This means you don’t have to keep multiple versions of a file at different print
sizes; you just create what you need on-the-fly. Perfect Resize also supports layered Photoshop files so you can maintain all your layers in the entire process.
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Supported Color Modes

When used as a standalone application or through Lightroom and Aperture, Perfect Resize supports 8 or 16 bit RGB images. These are the most common among
Photographers. 

If you use Perfect Resize through Photoshop, you have access to a larger range of color modes, depending on the version of Perfect Resize you have. Consult
the chart below for details.

Perfect Resize Standard Edition
Perfect Resize Lightroom & Aperture Edition
Perfect Resize Premium Edition via Standalone
Perfect Resize Premium via Lightroom or Aperture

Perfect Resize Premium Edition
via Photoshop 

RGB 8-bit  Yes  Yes

RGB 16-bit  Yes  Yes

Grayscale 8-bit  No  Yes

Grayscale 16-bit  No  Yes

Lab 8-bit  No  Yes

Lab 16-bit  No  Yes

CMYK 8-bit  No  Yes

CMYK 16-bit  No  Yes

Photoshop Layers  Yes  Yes

Layer Masks  Yes  Yes

Text Layers  No  Yes

Adjustment Layers  No  Yes

Alpha Channels  No  Yes

Paths  No  Yes

Smart Objects  No  No
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User Interface

The Perfect Resize Main Window

Perfect Resize provides you with an easy-to-use work area for editing your photos. Below is an overview of the main sections. 

The main sections of Perfect Resize:

A. Preset Browser: This panel is located on the left side of the window and is where you view a Library of presets.

B. Tool Well: This is where the tools are located.

C. Tool Options Bar: This strip above the preview window contains the options for the selected tool.
D. Preview Window: This is the main section where you preview and work on images.

E. Module Selector: This is where you select other modules to work in.

F. Control Panel: This is where you access the Control Panes.

The Perfect Resize Tool Well

There are three different tools in the Perfect Resize tool well. More details about each tool will be covered in the next chapters.

 Crop Tool  This tool lets you crop the image.

 Hand Tool  This tool drags your image within the preview window when it's larger than the viewable area.

 Zoom Tool  This tool changes the magnification in the preview window.
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Navigating the Preview

Resize Module 

This provides several ways to navigate and view your image in the Preview window. 

  

The Preview Window above is the main section where you preview and work on images.

 
 Hand Tool

The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area. 

 To pan (scroll) in the Preview window: 

Select the Hand Tool and drag the image until you locate the area you wish to view. 
With any other tool selected, hold down the spacebar while you drag the image in the window.

 

Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

 
Zoom Tool 

The Zoom tool changes the magnification of the image in the Preview window. 

With the Zoom tool selected:

Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

 

Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.
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Navigator, Loupe, Histogram and Info

At the top of the control panel on the right of the main window is the Navigator | Loupe | Histogram | Info panes. It contains four useful tools for
inspecting and viewing details of your image.

The Navigator Pane

This gives you a birds-eye view of your image. The blue square region marks the image area
that is visible in the preview pane. You can pan your image by clicking and dragging inside the
blue region. 

At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate. 

FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%

 

The Loupe Pane

This gives you a magnified view of the section of the preview under the cursor. This allows you
to view the quality of your results while maintaining a complete view of your image.

At the bottom of the Loupe Pane is a sliding for adjusting the zoom level.

 

The Histogram Pane

This gives you a color chart of the shadow, mid-tone and highlight areas based on the image
RGB values. This is useful to show areas within the image that may be clipping. Clipping is when
your image contains pure blacks or white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while the right represents the
highlights. At the top of each end is a triangle. If the triangle is lit, there is clipping on that side
of the histogram. If you click on the arrows, you will activate the clipping overlay on your
image. The areas of your image with a blue overlay are pure black, while the areas with the red
overlay are pure white. You can turn the clipping view off again by clicking on one of the
triangles. You can also temporarily enable clipping view by holding down the J key at any time.
The clipping view is useful when you are making adjusts to the brightness and contrast of your
image.

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.
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The Info Pane

The info pane will display important metadata about your file including:

Camera type
File type
Focal length and lens information
Date and time captured
Exposure information 

ISO
Shutter Speed
Aperture
Exposure Value

Filename
Color Space
Dimensions
File Size and Bit Depth

If your camera allows for GPS the GPS button will be viewable and you can click on it to get the
GPS cordinates for where the image was taken. This feature only works if you have GPS
enabled on your camera or mobile device. Otherwise you will not see the GPS button.

 
 The Info panel is not visible when you access Resize Module as a Photoshop plug-in.
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Browsing Presets

Built into Perfect Resize is a preset browser, located in the left panel. You can use it to browse the factory supplied presets, presets you have created or
downloaded from the onOne website or for marking and finding your favorites. Below is a description of the controls in the file browser.

 

A. Browser Tabs: This switches between the Library tab, Favorites tab and My
Presets tab.

B. Search Field: Use the search field to locate presets in the current tab. Simply start
to type and your results will appear in a new sub-category called search results while
you type.

C. Closed Category: A closed category has a dark gray tab and the arrow faces to
the right.

D. Open Category: An open category has a light gray tab and the arrow faces
down.

E. Preset: A preset is displayed by its name.

F. Favorite Flag: Click on the this flag to mark a preset as a favorite. It will appear in
the Favorites tab automatically.

G. Resize Handle: On the right edge is a resize handle that you can drag to change
the size of the browser or close it.

Browser Tabs

The Browser is divided into three tabs; Library, Favorites and My Presets.

Library: The Library tab contains the factory presets provided by onOne Software. They are a good place to start.
Favorites: When you click on the favorite flag on a preset, in any tab, it is added to the Favorites tab automatically. This makes it fast to find the
presets you use most frequently.
My Presets: When save your own presets, or install presets from the onOne website, they will be located here.

Navigating the Browser

To open a category, click on it. To close it, click on it again.

Only one top-level folder can be open at a time.
The selected item, either a category or preset, will have a light silver box around it.
You can use the up and down arrow keys to change your selection in the browser.
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You can open or close categories using the command (control on Windows) up and down arrows.

Selecting a Preset to Use

To activate a preset on your image, simply click on the preset.

Searching for Presets

To search for presets in the current browser tab, type in the name of the file in the search field.
The search results appear in a new sub-folder called search results, which will be selected automatically.
You can clear the search field by pressing the x at the right end of the search field.

Browser Pop-Up

To view a larger preview on a preset, enable the Show Browser Pop-up in the
View menu.
When you mouse over a thumbnail, a larger preview will be displayed in a pop-up
window.

 

 

Resizing and Closing the Browser

The browser can be resized by dragging the resize handle on the right margin of the browser.
The browser can be closed or reopened by clicking on the resize handle or using the cmd (control on Windows) left and right arrow keys.
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Using Perfect Resize

Pages in this Section 
Cropping the Image
Adjusting the Image Size
Using Document Size Presets
Settings
Sharpening
Film Grain
Tiling
Gallery Wrap
Presets
Menus
Keyboard Shortcuts
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The crop tool allows you to crop and resize your image at the same
time. Cropping removes any pixels outside the crop box and
changes the canvas size at the same time. To crop the image, select
the Crop Tool from the tool well. Then either select a crop preset or
drag a box over the area you wish to keep. The area outside the
crop box appears darkened for guidance. You can resize and move
the crop box. The crop is Perfect Resize does not need to be applied
or committed, it is always live until you apply your entire results.

Moving the Crop Box

To move the Crop Box, simply click and drag inside the box. You can
also nudge the box using the arrow keys on your keyboard.

   

Resizing a Crop Box

To resize the Crop Box, click and drag on any of the resize handles. Clicking on a corner handle allows you to adjust two sides at the same time. Clicking on
a side handle allows you to adjust that side. If you hold the shift key down while adjusting the size, the proportions of the box are maintained. 
 

Rotating a Crop Box

To rotate the Crop Box, move your cursor just outside of any of the corners. The cursor will change to a rotate cursor. Click and drag to rotate. 

 

Setting the Crop Size

There are two ways to preset the crop box size. The first is to select a document size preset from either the Crop Tool Options Bar, or the Document Size
pane. This will add a crop box to fix the image locked at the size and proportions of the preset. This is the fastest way to crop and resize your image at the
same time. You can then adjust the size and location of the crop box to best fit your composition.

You can also type in the size you desire into the width and height fields of the Crop Tool Options Bar, then drag out a crop box. This works similarly to a
Document Size Preset. It will lock the size and proportions of the crop box.

 

Cropping the Image

  
Crop Tool: This is used to crop the entire image. 
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The original image is 10”x8” at a resolution of 200 pixels per inch. 
Notice that the pixel dimensions are 2000 x 1600 pixels. 

2000 px = 10”x200 ppi
1600 px = 8”x200 ppi

 

   
By changing the width to 20” the height changes to 16” proportionally 
and automatically and the new pixel dimensions change to 4000 x 3200 pixels. 
Note the resolution does not change. 

4000 px = 20”x200 ppi
3200 px = 16”x200 ppi

Note the file size and percentage have changed as well.

 

 

Adjusting the Image Size

In Perfect Resize, you can adjust your image size using either the Pixel Dimensions or Document Size panes. The information in these panes are interrelated and
locked together. Adjusting the values in either pane will lead to changes in the other pane. To help explain this, lets use the example below.

Follow these steps to adjust the size of your image to what is desired for your output file. 

1. Launch Perfect Resize
2. Adjust width in the Document Size pane to your desired width. Note that the height will adjust automatically and proportionally. 
3. If needed, adjust the Resolution in the Document Size pane to what your printer or other output device needs. 
4. Press Apply.
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 Tip: Using Document Size Presets is the fastest way to get common sizes. They let you crop and resize your image simultaneously. 

Keep the proportions in mind because the proportions of films, digital camera sensors, and papers can all be different. For example, most digital
cameras sensors are proportioned so that the height is two-thirds the width or 1:1.5; While the most common paper size, in the US, is letter size
which is 8.5x11 inches or about 1:1.25. These kinds of proportion mis-matches are common and require that the original image be cropped to fit the
proportions of the paper size.

Tip: The constrain proportions option locks the original image proportions so that when you change a value, like width, 
in the Pixel Dimensions or Document Size Preset panes and the height will adjust automatically. This function is on by default and is always
recommenced to use. By turning Constrain Proportions off you can inadvertently stretch and distort your image.
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Document size presets allows you to crop and resize your image simultaneously. Often,
when you are using Perfect Resize it is to create a file for print output at a known
common size. In these cases, using a Document Size Preset can be the fastest way to
set your Document Size and crop your image to the needed proportions.

Follow these instructions to use a Document Size Preset:

1. Select your image and launch Perfect Resize.
2. Select your desired size from the Document Size preset pull-down in the

Document Size pane, or Crop Tool Options Bar. You will see that the Document
Size fields will be completed automatically for you and that a crop box is drawn
on your image matching the proportions of the Document Size Preset that you
selected.

3. If needed, select the rotate crop box to rotate your crop box to the proper
orientation. It will automatically rotate to match the orientation of your image,
but if you want to crop differently you may need to rotate it. 

4. Now, you can use the crop tool to reposition and change the size of the crop box
so that it contains just the image area that you want. Note that the crop box
proportions and Document Size are locked so that you will always have the
finished document size that you requested.

5. Adjust your resolution to what is needed for your output device. If you are
unsure what to select, use the resolution drop-down menu for common settings.

 

   

Perfect Resize 8 comes with many commonly used print, paper and video Document Size
Presets but also allow users to create their own.

To create your own Document Size Preset follow these instructions:

1. Select your image and launch Perfect Resize.
2. From the Document Size Preset pull-down, select custom > Manage Custom

Sizes.
3. Click on the Add button.
4. Double-click on the highlighted untitled name and name your preset. 
5. Double-click on the width and height and fill in the proper values. 
6. Click on the units and select the proper unit. 
7. Click on the Okay button.

Tip: If you select the incorrect Document Size Preset you can change it by selecting a different one. If you do not  

wish to use a Document Size Preset after you have selected one you can select “None” from the top of the Document 

Size Preset pull-down. Or you can click once outside the crop region with the crop tool to clear at any time.

Tip: The lock crop option locks the proportions and document size settings for the given crop. This is enabled by default 
when you use a Document Size Preset.

 

Using Document Size Presets
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The settings dialog contains the controls for selecting the resizing method, or algorithm, and its
settings. Every image is different and selecting the correct settings here can improve the
quality of the results. To help you get started, try one of the presets in the Image Type drop-
down menu.

Image Type: This pop-up contains presets that adjust the settings for Amount and Threshold
automatically. 

Method: The method drop-down selects the the method, or algorithm, used to resize the
image. The options are:

Genuine Fractals: This is the classic, patented, fractal-based algorithm that has made
Perfect Resize the standard for over a decade.
Perfect Resize Portrait: This is a new variation on the Genuine Fractals algorithm
designed for portrait images. It is slightly softer and does a better job representing skin
and hair textures.

Texture Controls
When you select the Genuine Fractals method there are several other controls that tune the
resizing algorithm based on the image. These deal with the texture of the image.  If you were
to analyze an image from a detail perspective you could break it into three categories: Edges,
Continuous Tone and Textures. Edges are obvious; these are the sharp details that define the
edges of the subject in your image. It’s paramount that these are maintained in order for your
enlargement to maintain quality. The continuous tone areas are things like skin or skies that are
mostly solid or graduated color. These resize easily as there is little detail in these areas. The
last area, what we call texture is areas that fall between these two. They are areas that still
contain detail but are not sharp edges. These are things like the surface of rocks, tree bark,
fabric, animal fur, etc. The amount of detail in these texture areas can have a large impact on
the perceived sharpness and quality of an image. In Perfect Resize you can control the key
algorithm variables that effect these areas. In Perfect Resize there are even presets for
different image types and subject matters that help you get the best results in reproducing
these textured areas.

Texture: This controls the amount of detail in flat, non-edge areas of an image. If your image
contains lots of small detail that does not have defined edges (many organic patterns like
leaves, rock, bark; or man-made patterns like fabric) it may be good to increase the amount to
a setting of 4 or 5. Settings beyond 5 will often introduce a bumpy noise pattern which is
undesirable unless your original image was from scanned film. Settings lower than the default 3
are useful for images with large areas of continuous tone that have no appreciable detail (sand,
snow, sky) but have hard edged foreground subjects such as landscape images, architecture or
portraiture.

Threshold: This controls the amount of hard edge detail that is enhanced. The default setting
is 25. Decreasing the threshold will focus the algorithms only on edge information. This may be
useful for portraiture or for reducing noise in your image. Settings higher than 25 will increase
the amount of small detail in flatter areas of the image. Settings as high as 100 are useful for
highly detailed images such as hair or feathers. Higher threshold settings will also make Perfect
Resize process faster. A good way to start adjusting these controls is by setting the threshold
to 100 and then move the amount up until the image is too noisy (bumpy) and then reduce the
threshold to smooth out the noise in continuous tone areas. For detailed images with no little or
no continuous tone, you might try the amount at 4 and the threshold at 100. For portrait
images or images with significant JPG artifacts you should try an amount of 2-3 and threshold of
25 or lower.

Smoothness: The smoothness slider is used to reduce artifacts along hard curved edges. Use
the lowest setting needed.

 

Tip: Always make sure your zoom is set to 100% or 1:1 when adjusting the controls
in the Texture Control Pane. 

 

 

Settings
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The sharpening pane contains the controls to add additional sharpness to your image. 

Perfect Resize features three different sharpening methods:

Unsharp Mask: Good for general sharpening. Similar to Photoshop's unsharp mask function
except it is only applied to the luminance of the image to prevent color artifacts.
Highpass: Highpass sharpening is helpful when the original image is not sharp.
Progressive: Similar to the unsharp mask except it sharpens different amounts depending on
the size of the details in the image. Small details are enhanced more than large ones.

Using the Sharpening controls can save you the workflow step of adding additional Sharpening before
printing and can help compensate for loss of sharpness due to dot gain from your printer. Sharpening
should only be applied at the end of your workflow just before printing. If you plan to do additional
retouching or compositing work after resizing your image, you should disable the Sharpening controls.

 

To sharpen your image for output, use these steps after you have adjusted the Document Size
pane controls. 

1. Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset located in the Navigator
pane.

2. Enable the Sharpening controls by toggling the on/off control in the Sharpening pane title bar.
3. Select the sharpening method that will provide the best results for your image. You may need to experiment

to determine this.
4. Adjust the amount slider to determine the amount of sharpening desired.
5. Use the Highlight and Shadow sliders to limit the sharpening from being applied to the darkest and lightest

areas of the image which can prevent sharpening of noise.

Sharpening Off Sharpening On

 

Sharpening

 
Tip: Keep in mind that this
sharpening is applied to the
entire image area. If you wish
to use a selective sharpening
technique you should disable
the Sharpening controls in
Perfect Resize.
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The Film Grain setting controls the amount of simulated Film Grain (noise) to
your image. Adding a modest amount of Film Grain can make your image
appear sharper visually and can help hide imperfections like JPG artifacts. This
is especially useful for monochrome images. Film Grain should only be added
just before printing. If you need to do other retouching or compositing work in
Photoshop after resizing your image, you should disable the Film Grain
controls.

To add Film Grain to your image follow these steps: 

1. Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset located in the Navigator pane.
2. Enable the Film Grain controls by toggling the on/off control in the Film Grain pane title bar.
3. Adjust the slider up or down until the desired amount of Film Grain is added.
4. You can preview just the effect of the Film Grain by toggling the Film Grain on/off control.

Film Grain Off

             

Film Grain On

 

Film Grain
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The tiling feature in Perfect Resize 7.5 will divide an enlargement into
smaller pieces that can be printed on a smaller printer. 

Lets say you want to create a mural that is 8 feet tall by 12 feet long
but your printer can only print 24 inch wide strips. With the tiling
feature you could automatically create four separate files that are
24" wide and 8 feet tall so you can create your mural in sections.
With the tiling feature all you do is specify the size of paper you have
to print on and if you would like the pages to overlap. Then Perfect
Resize 7.5 will resize your image and section it down into the
individual tiles.

 

 

   

To use the Tiling feature, follow these instructions:

1. Turn tiling on by toggling the on/off switch in the pane
header.

2. Set the Width and Height fields to the size and orientation of
paper that you wish to print on, or you can select the
number of rows and columns instead.

3. Set the Overlap size. The overlap makes each tile overlap so
you can tape multiple panels together and corrects for
printer margins if you are not printing borderless.

4. Set the file type for the newly created files for each tile.
5. Set the destination folder for the new files. Each file will be

named with the original filename and the tile indicated in the
filename.

The preview will show cyan guide lines for each tile that will be
created. The bottom of the Tiling pane will tell you how many tiles will
be created.

 

Tiling
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The Gallery Wrap feature is designed to help you print on canvas. When making
enlargements for canvas it is common to wrap a portion of the image around
wooden stretcher bars. These can be several inches thick and are used for
mounting the canvas. These are commonly called gallery wraps. However, if the
photographer had important detail near the edges of the image they may be lost in
the wrapping process. The Gallery Wrap feature in Perfect Resize Professional
Edition automatically creates extended margins by reflecting or stretching the areas
near the edge of the image allowing the photographer to create a gallery wrap
without having to sacrifice any of the original image. The Gallery Wrap feature
allows you to select the thickness of the canvas mounting bars and offers a variety
of techniques for creating additional margins.

  

To use the Gallery Wrap feature follow these instructions:

1. Turn on the Gallery Wrap feature by toggling the on/off switch in the pane
header.

2. Set the Thickness control to the amount of margins you would like to add. A
good rule of thumb is the thickness of the stretcher bars, plus half an inch.

3. Select the Type you would like to use.
4. If you wish to add a color overlay to the gallery wrap wings set the color

and opacity.

   

   

The Gallery Wrap feature has several methods for adding margins:

Type:
Reflect: Copies an area equal to the thickness setting around your image, then flips each side and adds it as the margins. This is a good
general purpose technique.
Reflect Soft: Does the same as the Reflect method but softens the added margins.
Stretch: The Stretch method takes a small area around the edge of the image and stretches it to add the margins.
Stretch Soft: Does the same as stretch, but softens the added margins.

Thickness: This how thick your canvas stretcher bars are. Generally two inches works well for most gallery wraps. 
Overlay Color: You can also add a color overlay over the wrap area. This can be used to darken the wrap or fill it with a solid color.
Opacity: This sets the opacity of the overlay color. At the default of zero, there is no color overlay added.
Add to New Layer: This places the wrap wings on their own layer, rather then merging them with the image.

 

Gallery Wrap
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Without the Gallery Wrap feature, important parts of the image get lost when
wrapped.

 With Gallery Wrap enabled, you can maintain the original image area
but still have the extended margins needed to wrap canvas on thick
stretcher bars.

   

Note: It is not recommended that you use the borderless printing option on a printer or use borderless lab prints when the overlap is set to
zero. Both borderless methods increase the image size 1-3 percent to allow for overprinting and/or trimming. The resulting prints may not
align properly. 
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Presets

Presets store all of the settings you can adjust in the the control panels on the right as well as the crop settings. Presets are a fast and easy way to get
consistent results. You can save your own presets for batch processing.

Using a Preset

Using a preset is simple, just click on it in the Preset Browser.

Saving a Preset

Saving a preset is simple. Once you have your settings that you wish to save, go to
the Preset menu and select Save Preset. 

The New Preset dialog will appear (shown to the right). There are several fields to
complete including the preset name, the category, creator and description.

In the category pull-down you can select which existing category the preset should
saved into. You can also create a new category this way by selecting new category
from the bottom of the list.

 

You can edit a preset's name, creator or description by selecting it and then
selecting Edit Preset Info from the Preset menu. If you want to edit the
settings in a preset, load it into, make your adjustments and then re-save
the preset with the same name and location. 

Deleting a Preset

You can remove a preset from Perfect Resize if you no longer want to have access to
it. To remove a preset, follow these steps:

1. Open Perfect Resize
2. Select the preset you wish to remove in the preset browser.
3. Select Delete Preset from the Preset menu.

 

Importing & Sharing Presets

You can import presets you have downloaded from the onOne website using these
steps.

1. Download the preset pack from the onOne website. It should have a
.ONPreset extension.

2. Double-click on the preset pack, it will install the presets into a category
named the same as the preset pack.

That's it, next time you use Perfect Resize the new presets will be located in the My
Presets tab, in a category named after the preset pack. You can delete the files you
downloaded, they have been copied into Perfect Resize.

You can share presets like you would share any other file, such as email or posting
them to a website. First you need to find the preset files. The easiest way it to open
Perfect Resize, then from the Preset menu select Show Presets Folder. A Finder
(Mac) or Explorer (Win) window will open and will display the presets folder. In the
presets folder are sub-folders for your preset categories. Inside each sub-folder are
the individual preset files, with a .ONResize extension. You can copy these presets
to another computer, attach them to an email or post them on a website.
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About Perfect Resize: Opens the about dialog box. It contains your serial number, version
number and information on contacting onOne Software for support.

Preferences: Opens the Perfect Resize preferences dialog. 

Services: Opens the OS level Services flyout (Mac only).

Hide Perfect Resize: Hides the window.

Quit Perfect Resize: Quits Perfect Resize.

File Menu
 

 

Cancel: Cancels Perfect Resize and returns back to the host application with no changes.

Apply: Applies the current document size settings and options to your image and returns to the host application.

 

Edit Menu  
 

Undo: Reverses adding a preset

Redo: Unused 

Copy: Unused

Cut: Unused

Paste: Unused

Reset All: Resets all the controls back to their default settings.

Module Settings: Opens the Perfect Resize 7.5 settings dialog.

 

 

Menus

Application Menu

 

 Tip: On Windows, the preferences can be found in the Edit menu and the About Box can be found in the Help menu.
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Preset Menu  
 

Save Preset: Saves the current settings as a new preset.

Delete Preset: Deletes the current preset.

Edit Preset Info: Opens the preset dialog so you can edit
the name, author or description information.

Import Preset: Opens the import preset dialog to help you
import presets you have downloaded.

Show Presets Folder: Opens a Finder or Explorer window
showing the presets folder. 

Manage Extras: Opens the Extras Manager where you can
import and manage extras like Borders, Backgrounds,
Textures and Presets.

 

View Menu
  

Zoom In: Zooms the preview window in one increment. This will make the preview image
larger.

Zoom Out: Zooms the preview window out one increment. This will make the preview
image smaller.

Fit to Screen: This sets the preview image so that the entire image is on screen at
once. Think of this as an overview of the entire image. This is the setting you will use
most of the time.

Fill with Layer: Sets the zoom so the current layer fills the entire screen.

Actual Pixels: This sets the preview image so that it zooms to actual pixels or 1:1 also
called 100%. This setting allows you to see every pixel in the image. This is useful when
making adjustments to the Settings, Sharpening or Film Grain.

Show Browser Pop-up: Enables the browser pop-up window. A checkmark should
appear next to this when it is enabled.

Show Clipping: Shows the clipping overlay view, which overrides the current mask
view. No checkmark is displayed for this mode. The user can temporarily show this mode
by holding down J as well.

Preview Background Color: Flyout with background color options, the selected
item should have a checkmark next to it.

 

Window Menu
  

Navigator/Loupe/Histogram: Opens or closes the Navigator/Loupe/Histogram
pane.

Pixel Dimensions: Opens or closes the Pixel Dimensions pane.

Document Size: Opens or closes the Document Size pane.

Settings: Opens or closes the Settings pane.

Sharpening: Opens or closes the Sharpening pane.

Film Grain: Opens or closes the Film Grain pane.

Tiling: Opens or closes the Tiling pane.

Gallery Wrap: Opens or closes the Gallery Wrap pane.

Solo Mode: Enables or disables Solo Mode.

Show Browser Panel: Opens or closes the Browser Panel.

Show Control Panel: Opens or closes the Control Panel.

Hide Panel: Opens or closes all Panels.

Full Screen: Opens the window to full screen.
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Help Menu
  

Search: Searches the Menus (Mac only)

Perfect Resize Online Help: Opens this html help in your default web
browser.

Video Tutorials: Opens a web browser to the tutorial section of the onOne
website.

Getting Started: Opens the Getting Started section in your default web
browser.

Keyboard Shortcuts: Opens a dark style dialog that displays the keyboard
shortcuts for that platform.

Perfect Inspiration: Opens the onOne Perfect Inspiration Gallery in your
default web browser.

Check For Updates: Checks for updates with the onOne auto update server.

Deactivate: Opens the activation dialog. This is used to deactivate your
software so you can move it to another computer or make a return.

Register: Opens the default web browser and navigates to the registration
page.

Provide Feedback: Opens the default web browser and navigates to the
feedback page.

Help Improve onOne Products: Opens the Improve onOne Products dialog.

 

70  Perfect Resize

Perfect Resize



 

Keyboard Shortcuts

Action  Mac  Win

 Preferences  cmd ,  ctl k

 Undo  cmd z  ctl z

 Redo  cmd shift z  ctl shift z

 Open/Close Navigator Pane  cmd 1  ctl 1

 Open/Close Pixel Dimensions Pane  cmd 2  ctl 2

 Open/Close Document Size Pane  cmd 3  ctl 3

 Open/Close Settings Pane  cmd 4  ctl 4

 Open/Close Sharpening Pane  cmd 5  ctl 5

 Open/Close Film Grain Pane  cmd 6  ctl 6

 Open/Close Tiling Pane  cmd 7  ctl 7

 Open/Close Gallery Wrap Pane  cmd 8  ctl 8

 Open/Close Browser Panel  cmd left arrow  ctl left arrow

 Open/Close Control Panel  cmd right arrow  ctl right arrow

 Hide Panels  tab  tab

 Full Screen Mode  cmd ctl f  F11

 Select Pan Tool  h  h

 Select Zoom Tool  z  z

 Select Crop Tool  c  c

 Zoom-In  cmd + or cmd =  ctl + or ctl =

 Zoom-Out  cmd -  ctl -

 1:1  cmd opt 0  ctl alt 0

 Fit to Screen  cmd 0  ctl 0

 Fit to Layer  cmd shift 0  ctl shift 0

 Show Clipping  opt J  alt J
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Perfect Batch

Perfect Batch is an engine for automating processes or applying presets that are available in each
module.  It is ideal for applying universal adjustments across a large number of images.  It can be
launched from the Browse module or through Perfect Layers. There are a number of reasons to use a
Batch process.  

Some features of onOne Batch include:

Convert Files:  Select a source folder and create a new child folder and convert a large
number of files to a new desired format.
Resize Files:  Prepare files for printing, web or simply changing the dimension and/or
resolution.
Apply Module Presets:  Use the factory presets or apply your own custom preset created
from Perfect; Enhance, Portrait, Effects, B&W and Resize.
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This getting started section will give you the basics of using Perfect Batch. If you have never used Perfect Batch before, this is a good place to start. You
might also try watching the getting started video tutorial. For detailed information on steps and controls mentioned in the getting started section, see the
"Using Perfect Batch" section instead. 

Pages in this Section
Batch Workspace
How to Access Batch

 

 

Getting Started
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Batch Workspace

To launch the Batch dialog box you must first be inside of either Perfect Layers or the Browse module.  Go to File > Batch to bring up the workspace dialog box.
 Within this dialog box you will be able to select a source, the preset(s) that will be applied, the destination and even place a watermark on the image.  

The Batch Dialog:
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How to Access Batch

 Launch the stand alone application of Perfect Photo Suite 8. The Batch module can be accessed inside of

either Browse or Perfect Layers. Go to File > Batch and this will launch the batch dialogue. 

You can also select a group of images in the Browse module and select Perfect Batch from the right-click

contextual menu.

 

  

 You can also access Perfect Batch inside of Adobe Photoshop, Adobe Lightroom or Apple Aperture.  
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This section covers the complete use of Perfect Batch. It includes how to select files, adding a
module preset and saving to a destination. 

Pages in this Section
Selecting Files
Adding a Module
Destination Pane
Batch Presets

 

 

Using Perfect Batch
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 The first step to beginning a Batch process is to select the Folder or Files.  The Source defines those Files or Folders. There are
two ways to choose the Source. 

 

Selected Items:  Inside of Browse you can simply select the the Folder or Files before going to File > Batch. The Source drop
down menu will read "Selected Items."

Folder: This option will require you to click the Choose button.  The Choose button presents you with a Finder or Windows
Explorer dialogue where you will navigate to and select a Folder.  After you have a folder selected the description will appear next
to Folder. 

Include SubFolders: If this box is checked the Batch will also process any that reside within subfolders of the parent Folder you
have selected.  

 

Selecting Files
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 After you select a source you choose the module(s) you wish to use for the Batch process.  

Each Module has its own pane that contains a choice of Type, Category and Preset.  

If you are not familiar with Presets we recommend you review the Preset pages for each module to better understand how this works.

 

Type:  Choose between either a Factory
Preset or a Personal Preset you have
created or installed.
Category:  Select the category in which
the Preset lives.
Preset:  Pick the preset you want to
apply during the Batch.
Pause on the first image:  When
checked the first image is processed and
the batch will pause so you can
evaluate.  

The Perfect Resize module includes additional
options for output. You can apply a preset, either
factory supplied or a user saved preset, or you
can enter the size you desire. If you manually
enter a size you can select to fit in a specified size
(width & height) or to scale the long or short side
of the images to a specified dimension. This can be
good for resizing images for web or for proofs.

 

 

Adding a Module
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The Watermark module allows you to add an
overlay to the image, typically used for your logo,
signature or copyright.  

File:  Click the Choose button to select
the file you wish to use as your
watermark.
Size:  This slider controls the size of the
watermark file.  
Inset:  This will determine the percentage
in which the file is inset from the edge.
Opacity:  This sets the opacity of the
watermark.
Location:  This grid sets the location of
the watermark.  Click on the square of the
location you desire.
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Destination Pane
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The destination pane is the last step in the Batch
workflow.  This determines where the processed
files are saved, how they are named, the file type
and additional options. 

Save To: This drop down
menu includes three options; Round
Trip, Current Location or Folder.
 Roundtrip saves the file over the
original and uses the same file
format, bit-depth, color space and
name. Naturally all the additional
options will be grayed when this
option is selected.  Current
Location will write the file to the
same location as the original file.
 The Folder option will allow you to
choose a new location the files will
be saved to. Click the Choose
button to select the new location.  
Folder: The Folder will list the path
the file is going to be saved. This
line will only be seen when the
Folder option is selected under
Save To.
Put in Subfolder:  When checked
this will create a subfolder in the
destination and you may name the
subfolder in the field on the right. 
Match Source Folders:  When
checked this option will match the
hierarchy of the source folder.
Existing Files:  This drop down
determines what will happen if
there is a file name conflict.
Overwrite without warning or
Prevent overwrite. If Prevent
overwrite is chosen the word 'copy'
will be added to the file(s).  
File Type:  This drop down
determines the file format or
extension.  The choices include;
 Same as Source, Photoshop,
Photoshop Large Document, JPEG,
TIFF and PNG. The quality slider is
only available for JPEG.
Color Space:  This drop down will
include all the available color
profiles installed on your system.  
Naming Element:  This option
may be used to determine the file
name. The options include;
 Current Name, Text and Number.
 The field to the right allows you to
enter a custom name.  The plus
and minus icons will allow you to
add or remove naming elements.
 Current Name will use the source
name without the file extension.
Text is used for assigning a custom
text string.  Number creates an
automatically incremented number,
starting with the number input in
the field. 
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Batch Presets

Presets for the Batch settings can be saved and used again.  Presets will remember all of the settings and details selected on the right, in the Batch
dialogue.  

 

Saving Presets:  To save a preset click the "+" icon at the lower left.  This opens a preset dialogue
where you define the name, category, creator and description.  
Using Presets:  To use a preset simply double click on the name.  This will load the preset settings in
the batch dialogue.
Deleting Presets:  To delete a preset select the item and click the "-" icon at the bottom left. 
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